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1 Introduction

1.1 About this document

1.1.1 Description of the contents
This manual describes the Hilscher EU5C-SWD-SERCOS SmartWire‑DT
Gateway. Here you will find information on how to install, configure and
operate the gateway.

This manual is intended for automation technicians and engineers. Detailed
knowledge of the SERCOS Real-Time Ethernet system is presumed. In
addition, readers should also be familiar with the SmartWire-DT system.

Important:
Ø To avoid personal injuries or damage of electrical devices,

please read this manual carefully before installing and using the
EU5C-SWD-SERCOS Gateway.

Ø Please first read the chapter Safety [} page 15].

1.1.2 List of revisions
Index Date Revisions
1 2017-02-16 Document created

Table 1: List of revisions
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1.1.3 Conventions in this document
Notes, operation instructions and results of operation steps are marked as
follows:

Notes

Important:
<important note>

Note:
<simple note>

<note, where to find further information>

Operation instructions

1. <operational step>
Ø <instruction>
Ø <instruction>

2. <operational step>
Ø <instruction>
Ø <instruction>

Results

 <intermediate result>

 <final result>

For a description of the labeling of Safety Messages, see section Labeling
of safety messages [} page 19].
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1.2 Versions of devices, firmware, software tools and drivers
The hardware revisions and software versions functionally belong together.
This means that certain revisions of the hardware of the gateway need
certain versions of firmware, software and drivers, in order to function
properly. 
This section lists the hardware revisions and the versions of the firmware,
the configuration software and the drivers which functionally belong
together and to which all instructions in this manual refer.

Device and firmware

This manual refers to the following hardware revision and firmware version
of the EU5C-SWD-SERCOS Gateway:
Device type name Protocol Part number Hardware

revision
Firmware Firmware

version
EU5C-SWD-SERCOS Sercos slave 9233.923 1 E030J0U0.nxf 1.0.x.x

Table 2: Reference to hardware and firmware

Software tools

This manual refers to the following software versions:
Software Manufacturer Version
SWD-Assist Eaton 2.xx

Table 3: Reference to software tools

Drivers

This manual refers to the following driver versions:
Driver File name Version
Windows USB Driver usbser.sys Depending on

Windows version
Table 4: Reference to drivers
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1.3 Software package

1.3.1 Overview
Hilscher offers the optional software package EU5C-SWD-SW (part
number 3233.920) for SmartWire-DT Gateways. The package features the
SmartWire-DT Gateway Solutions product DVD and a Mini-USB cable.
The SmartWire-DT Gateway Solutions product DVD contains the SDDML
files (SERCOS Device Description Markup Language) necessary for
configuring the EU5C-SWD-SERCOS gateway and the SmartWire-DT
modules within the Sercos network. If you do not need the whole package
with the USB cable, you can download the contents of the product DVD
separately and free of charge as ZIP file from our website
www.hilscher.com under Products > Partner Products > SmartWire-DT >
EU5C-SWD-SERCOS > Downloads > Software.

1.3.2 Contents of the product DVD
The SmartWire-DT Gateway Solutions product DVD contains software for
all types of SmartWire-DT gateways. Depending on the gateway type you
are using, you will need only certain features of the DVD.

The product DVD includes:
· Device description files
· Firmware
· Eaton SWD-Assist software
· Wizard for installing the software available on the DVD and for

downloading the latest version of the SWD-Assist software from the
internet

· Installation program for USB driver (USB driver is needed for
connecting the gateway to a PC in order to use the Eaton SWD-Assist
software)

· Installation program for the Hilscher Ethernet Device Configuration Tool
· Documentation in PDF format
· Installation program for Adobe Reader

SmartWire-DT Gateway | EU5C-SWD-SERCOS 
DOC160805UM01EN | Revision 1 | English | 2017-02 | Released | Public

© Hilscher 2017

http://www.hilscher.com/


Introduction 9/95

The product DVD has the following directories:
Directory Contents
Documentation PDF manuals in German and English and installation program for Adobe Reader
EDS SDDML device description files of the Gateway and of the SmartWire-DT modules in

compressed SDDML.zip folder. After unpacking, the device description files can be
imported into the IndraWorks engineering tool.

Firmware Loadable gateway firmware
fscommand Files for start screen of product DVD
Setups & Drivers SWD-Assist software

Folder: SWD-Assist

Wizard for installing the software available on the DVD and for downloading the latest
version of the SWD-Assist software from the internet
Folder: Setup

Installation program for Ethernet Device Configuration Tool
Folder: EnDeviceCfg

Installation program (setup.exe) and .INF- and .CAT- files for Windows USB driver.
Folder: USB Driver

Table 5: Directory of the product DVD

Note:
You can use the wizard on the product DVD to download updates of
the Eaton SWD-Assist software, or you can download SWD-Assist
directly from the www.moeller.net website under Support >
Download Center. Direct link: 
http://downloadcenter.moeller.net/en/software.a487d8b7-
da91-486f-b3ba-a7ca2035db99
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1.3.3 How to use the product DVD
Insert the SmartWire-DT Gateway Solutions product DVD into the DVD
drive of your configuration PC. 
If the auto start function of your DVD drive is enabled, the start screen of
the DVD automatically opens. You can also start the DVD by double-
clicking the SmartWire.exe file in the root directory of the DVD.

In the menu of the start screen of the DVD, click Install Planning and
Configuration Tools to open a wizard for installing the software programs
stored on the DVD. The wizard also helps you to download the latest
version of the Eaton planning software SWD-Assist from the internet. It
automatically checks for already installed software components (which e. g.
might have been installed for an earlier project), and lists the missing
components accordingly. The following options might be offered:
· USB Driver: installs USB driver for Windows on your PC.
· Download Center SWD-Assist (manual check): connects your

browser to a web page from which you can download the latest version
of the SWD-Assist software.

· SWD Planning Software SWD-Assist Vx.xx: installs the SWD-Assist
software version provided on the DVD.

· Ethernet Device Scanner/Configuration Tool: installs the Hilscher
Ethernet Device Configuration Tool.

· GSDML, EDS, SDDML, ESI files (HTML page): opens a web page
containing links to the device description files.

In the main menu of the start screen of the DVD, you can furthermore open
a web page which provides an overview of all available documents (menu
Documentation). You can also directly open the folder containing the
device description files (menu Open Electronic Device Description Files
Directory).

1.3.4 Notes on installing the USB Driver
If you intend to use the SWD-Assist software, you should first install the
USB driver on your PC before you connect the gateway via USB.

To install the USB driver from the DVD, choose Install Planning and
Configuration Tools in the DVD menu to open the installation wizard, and
then select the USB driver option. As an alternative, you can use the
Windows Explorer to open the Setups & Drivers\USB Driver folder
on the DVD, and then double-click the setup.exe file. Just follow the
instructions of the installation routine afterwards.

If you want to remove the USB driver from your PC, choose Start menu >
Control Panel > Uninstall a program, then select: 
Windows Driver Package – Hilscher GmbH (hilusbser) Ports entry.
Click Uninstall/Change button to uninstall the driver.
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1.4 Documentation overview
Besides this user manual at hand (path on product DVD: Documentation
\english\2. Hardware\EU5C-SWD-SERCOS UM xx EN.pdf), the
following documents are also relevant for the user of the EU5C-SWD-
SERCOS Gateway:

Title Contents Publisher Document ID Path on product DVD
SmartWire-DT
Modules

Information on
engineering, installation
and programming of the
individual SmartWire-DT
slaves.

Eaton MN05006001Z-EN Documentation\english\
3.SmartWire-DT\SmartWire-
DT – Units\
MN05006001Z_EN.pdf

SmartWire-DT
The System

Information on function,
installation,
commissioning and
diagnostics of the
SmartWire-DT system.

Eaton MN05006002Z-EN Documentation\english\
3.SmartWire-DT\SmartWire-
DT - The System\
MN05006002Z_EN.pdf

SWD-Assist 
Online help

Online help for SWD-
Assist planning software

Eaton - Included in SWD-Assist software

Table 6: Documentation overview
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1.5 Legal notes

1.5.1 Copyright
© Hilscher Gesellschaft für Systemautomation mbH

All rights reserved.

The images, photographs and texts in the accompanying material (user
manual, accompanying texts, documentation, etc.) are protected by
German and international copyright law as well as international trade and
protection provisions. You are not authorized to duplicate these in whole or
in part using technical or mechanical methods (printing, photocopying or
other methods), to manipulate or transfer using electronic systems without
prior written consent. You are not permitted to make changes to copyright
notices, markings, trademarks or ownership declarations. The included
diagrams do not take the patent situation into account. The company
names and product descriptions included in this document may be
trademarks or brands of the respective owners and may be trademarked or
patented. Any form of further use requires the explicit consent of the
respective rights owner.

1.5.2 Important notes
The user manual, accompanying texts and the documentation were created
for the use of the products by qualified experts, however, errors cannot be
ruled out. For this reason, no guarantee can be made and neither juristic
responsibility for erroneous information nor any liability can be assumed.
Descriptions, accompanying texts and documentation included in the user
manual do not present a guarantee nor any information about proper use
as stipulated in the contract or a warranted feature. It cannot be ruled out
that the user manual, the accompanying texts and the documentation do
not correspond exactly to the described features, standards or other data of
the delivered product. No warranty or guarantee regarding the correctness
or accuracy of the information is assumed.

We reserve the right to change our products and their specification as well
as related user manuals, accompanying texts and documentation at all
times and without advance notice, without obligation to report the change.
Changes will be included in future manuals and do not constitute any
obligations. There is no entitlement to revisions of delivered documents.
The manual delivered with the product applies.

Hilscher Gesellschaft für Systemautomation mbH is not liable under any
circumstances for direct, indirect, incidental or follow-on damage or loss of
earnings resulting from the use of the information contained in this
publication.
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1.5.3 Exclusion of liability
The software was produced and tested with utmost care by Hilscher
Gesellschaft für Systemautomation mbH and is made available as is. No
warranty can be assumed for the performance and flawlessness of the
software for all usage conditions and cases and for the results produced
when utilized by the user. Liability for any damages that may result from the
use of the hardware or software or related documents, is limited to cases of
intent or grossly negligent violation of significant contractual obligations.
Indemnity claims for the violation of significant contractual obligations are
limited to damages that are foreseeable and typical for this type of contract.

It is strictly prohibited to use the software in the following areas:
· for military purposes or in weapon systems;
· for the design, construction, maintenance or operation of nuclear

facilities;
· in air traffic control systems, air traffic or air traffic communication

systems;
· in life support systems;
· in systems in which failures in the software could lead to personal injury

or injuries leading to death.

We inform you that the software was not developed for use in dangerous
environments requiring fail-proof control mechanisms. Use of the software
in such an environment occurs at your own risk. No liability is assumed for
damages or losses due to unauthorized use.

1.5.4 Warranty
Although the hardware and software was developed with utmost care and
tested intensively, Hilscher Gesellschaft für Systemautomation mbH does
not guarantee its suitability for any purpose not confirmed in writing. It
cannot be guaranteed that the hardware and software will meet your
requirements, that the use of the software operates without interruption and
that the software is free of errors. No guarantee is made regarding
infringements, violations of patents, rights of ownership or the freedom from
interference by third parties. No additional guarantees or assurances are
made regarding marketability, freedom of defect of title, integration or
usability for certain purposes unless they are required in accordance with
the law and cannot be limited. Warranty claims are limited to the right to
claim rectification.
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1.5.5 Export regulations
The delivered product (including the technical data) is subject to export or
import laws as well as the associated regulations of different counters, in
particular those of Germany and the USA. The software may not be
exported to countries where this is prohibited by the United States Export
Administration Act and its additional provisions. You are obligated to
comply with the regulations at your personal responsibility. We wish to
inform you that you may require permission from state authorities to export,
re-export or import the product.

1.5.6 Registered Trademarks
Adobe Reader®  is a registered trademark of Adobe Systems Incorporated.

IndraWorks®  is a registered trademark of Bosch Rexroth AG.

Sercos® and Sercos® interface are registered trademarks of Sercos
International e. V., Süssen, Germany.

SmartWire-DT® is a registered trademark of Eaton Corporation.

Windows® XP, Windows® 7 and Windows® 8 are registered trademarks of
the Microsoft Corporation.

All other mentioned trademarks are property of their respective legal
owners.
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2 Safety

2.1 General note
The user manual, all accompanying texts and the documentation are
written for the use of the products by educated personnel. When using the
products, all safety instructions, property damage messages and all valid
legal regulations have to be observed. Technical knowledge is presumed.
The user has to assure that all legal regulations are obeyed.

2.2 Intended use
The purpose of the EU5C-SWD-SERCOS Gateway described in this user
manual is to create a connection between SmartWire-DT slaves and a
Sercos master in an overriding Sercos network.

2.3 Personnel qualification
The gateway must be installed, configured and removed by qualified
personnel only. Job-specific technical skills for people professionally
working with electricity must be present concerning the following issues:
· Safety and health at work
· Mounting and connecting of electrical equipment
· Measurement and analysis of electrical functions and systems
· Evaluation of the safety of electrical systems and equipment
· Installing and configuring IT systems

2.4 References safety
[S1] ANSI Z535.6-2006 American National Standard for Product Safety Information in

Product Manuals, Instructions, and Other Collateral Materials
[S2] IEC 60950-1, Information technology equipment - Safety - 

Part 1: General requirements,
(IEC 60950-1:2005, modified); German Edition EN 60950-1:2006

[S3] EN 61340-5-1 and EN 61340-5-2 as well as IEC 61340-5-1 and IEC 61340-5-2
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2.5 Safety instructions to avoid personal injury
To ensure your own personal safety and to avoid personal injury, you must
read, understand and follow the following safety instructions in this manual
and all warning messages before you install and operate the gateway.

2.5.1 Electrical shock hazard
Take care of the following safety measures before installing or uninstalling
the gateway:
· First disconnect the power plug of the device.
· Make sure that the device is disconnected from the power supply.
· Cover or enclose neighboring units that are live.

Devices that are designed for mounting in housings or control cabinets
must only be operated and controlled after they have been installed with
the housing closed. Desktop or portable units must only be operated and
controlled in enclosed housings.

2.5.2 Danger of unintended starting up of machines
· Install automation devices and related operating elements in a way that

they are well protected against unintentional operation.
· Emergency stop devices complying with IEC/EN 60204-1 must be

effective in all operating modes of the automation devices. Unlatching
the emergency-stop devices must not cause restart.

· You must take safety precautions (emergency switching off) in the
external circuitry of the gateway and any power modules type EU5C-
SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To do so, plan to
switch off the power supply to the contactor coils AUX.

· Measures should be taken to ensure the proper restart of programs
interrupted after a voltage dip or failure. This should not cause
dangerous operating states even for a short time. If necessary,
emergency stop devices should be implemented.

· Wherever faults in the automation system may cause damage to
persons or property, external measures must be implemented to ensure
a safe operating state in the event of a fault or malfunction (for example,
by means of separate limit switches, mechanical interlocks etc.).

SmartWire-DT Gateway | EU5C-SWD-SERCOS 
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2.6 Safety instructions to avoid property damage
To avoid damage to your gateway or your communication system, you
must read, understand and follow the following safety instructions and all
safety instructions and warnings in this manual concerning property
damage, before you install and operate the gateway.

2.6.1 General safety instructions concerning supply voltage
· In safety-relevant applications the power supply providing power to the

SmartWire-DT system must feature a PELV power feed module
(protective extra low voltage).

· Switch off the power supply if you are reconnecting slaves in the
SmartWire-DT system or reconnecting the ribbon cable connection.
Otherwise the SmartWire-DT slaves can be destroyed!

· The gateway has protection against polarity reversal for the 24-V-DC-
POW supply. However, if the gateway is connected via the serial
interface to an earthed device (for example to a PC), the gateway can
be destroyed, if the polarity of the power supply is reversed!

· The functional earth (FE) must be connected to the protective earth
(PE) or to the potential equalization. The system installer is responsible
for implementing this connection.

· Connecting cables and signal lines should be installed so that inductive
or capacitive interference does not impair the automation functions.

· Suitable safety hardware and software measures should be
implemented for the I/O interface so that a line or wire breakage on the
signal side does not result in undefined states in the automation
devices.

2.6.2 Device destruction by exceeding allowed supply voltage
The gateway must only be operated with the specified supply voltage.
· Make sure that the limits of the allowed range for the supply voltage are

not exceeded. A supply voltage above the upper limit can cause severe
damage of the gateway!

· A supply voltage below the lower limit can cause malfunction of the
gateway!

· Ensure a reliable electrical isolation of the low voltage for the 24 volt
supply. Only use power supply units complying with IEC 60364-4-41
(VDE 0100 Part 410) or HD 384.4.41 S2.

The allowed range for the supply voltage is indicated in section Technical
data EU5C-SWD-SERCOS gateway [} page 89].
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2.6.3 Electrostatic sensitive device
The gateway is sensitive to electrostatic discharge, which can cause
internal damage and affect its normal operation. Therefore adhere to the
necessary safety precautions for components that are vulnerable to
electrostatic discharge when you install or remove the gateway. Follow the
guidelines listed hereafter when you handle the gateway:
· Touch a grounded object to discharge potential static before you handle

the gateway.
· Wear an approved grounding wrist strap.
· If possible, use a static-safe workstation.
· When not in use, store the device in appropriate static-safe packaging.
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2.7 Labeling of safety messages
In this document the safety instructions and property damage messages
are designed according both to the internationally used safety conventions
as well as to the ANSI Z535 standard.
· The Section Safety Messages at the beginning of a chapter are

pinpointed particularly and highlighted by a signal word according to the
degree of endangerment. The kind of danger is specified exactly by the
safety message text and optionally by a specific safety sign.

· The Integrated Safety Messages embedded in operating instructions
are highlighted by a signal word according to the degree of
endangerment. In the safety message, the nature of the hazard is
indicated.

Signal words and safety signs in safety messages on personal injury

Signal word Meaning
Indicates a direct hazard with high risk, which will have as consequence
death or grievous bodily harm if it is not avoided.
Indicates a possible hazard with medium risk, which will have as
consequence death or (grievous) bodily harm if it is not avoided.
Indicates a minor hazard with medium risk, which could have as
consequence personal injury if it is not avoided.

Table 7: Signal words in safety messages on personal injury

Safety sign Sort of warning or principle
Warning of lethal electrical shock

Principle: Disconnect the power plug

Table 8: Safety signs in messages on personal injury

Signal words and safety signs in safety messages on property
damage

Signal word Meaning
Indicates a property damage message

Table 9: Signal words in safety messages on property damage

Safety sign Sort of warning or principle
Warning of property damage by electrostatic discharge

Table 10: Safety signs in safety messages on property damage
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3 Description of the EU5C-SWD-SERCOS gateway

3.1 Function
The EU5C-SWD-SERCOS gateway integrates a SmartWire-DT network
into a Sercos network. The gateway creates a data connection between the
participants (the slave devices) of the subordinate SmartWire-DT network
and the master device or PLC of the super ordinate Sercos network.

The gateway acts as master (a.k.a. “Coordinator”) in the SmartWire-DT
network on the one hand, and on the other hand as modular slave in the
Sercos network. It thereby presents each connected SmartWire-DT
participant as individual module to the Sercos master.

The cyclic process data is exchanged transparently between both
networks. 492 bytes of process input/output data can in sum be exchanged
with up to 99 SmartWire-DT participants (slaves). 
The maximum amount of “Consumed Data“ (including “Connection Control“
and “IO Control”) as Sercos slave is 246 bytes, maximum amount of
“Produced Data“ (including “Connection Control“ and “IO Status”) is also
246 bytes.

Figure 1: Data flow EU5C-SWD-SERCOS Gateway
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3.2 Configuration

3.2.1 SmartWire-DT configuration
The EU5C-SWD-SERCOS Gateway is easily commissioned by an
automated configuration function: On pushing the configuration button on
the front of the gateway, the gateway scans the current SmartWire-DT
network configuration, the so-called actual configuration. It then stores the
actual configuration as target configuration zero voltage-safe in the device,
thus making the target configuration available for a comparison of actual
and targeted SmartWire-DT configuration, which takes place each time the
gateway is being switched on.

When the gateway is switched on after a target configuration has already
been stored, the gateway automatically rescans the connected actual
configuration and checks it against the target configuration. If the gateway
recognizes that a required SmartWire-DT slave cannot be reached or a
wrong slave type is determined, it will not go into operation. If the actual
configuration complies with the target configuration, the gateway gets ready
for Sercos and waits for the Sercos configuration. The gateway checks the
project configuration, which it receives from the Sercos master, against the
target configuration. Discrepancies between target and project
configuration are indicated by the Config LED of the gateway.

Eaton SWD-Assist planning software

Despite the fact that you can configure the SmartWire-DT network in the
gateway simply by using the configuration button, it is nevertheless
recommended to use the SWD-Assist software to plan, dimension and
document the SmartWire-DT network.

For further information, please refer to the SWD-Assist online help.

Note:
You will find the Eaton SWD-Assist software on the product DVD,
which is included in the EU5C-SWD-SW software package (order
number 3233.920) available from Hilscher. 
You can use the wizard on the product DVD to download updates of
the Eaton SWD-Assist software, or you can download SWD-Assist
directly from the www.moeller.net website under Support >
Download Center. Direct link: 
http://downloadcenter.moeller.net/en/software.a487d8b7-
da91-486f-b3ba-a7ca2035db99
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3.2.2 Sercos configuration
The gateway is commissioned in Sercos by using the Sercos engineering
tool IndraWorks and SDDML (SERCOS Device Description Markup
Language) files in XML format. The device description file of the gateway
and also the files of the individual SmartWire-DT participants (a.k.a.
“slaves” or “modules”) must be imported into the engineering tool. They are
stored in the SDDML.zip archive in the EDS\EU5C-SWD-SERCOS
\Vx.x.x.x. directory of the product DVD. 
For detailed information, see section Configuring gateway in
Sercos [} page 40].

Note:
The SDDML.zip archive contains only files of SmartWire-DT slaves
which were officially listed as available products when the archive
was created.

3.3 Interfaces
The gateway features a SmartWire-DT interface (plug, 8-pole), a 2-port
switch Ethernet interface (RJ45) for connecting Sercos, and a Mini-USB
interface. Via the Mini-USB interface, the gateway can be accessed,
configured and diagnosed with the SWD-Assist software.

3.4 Diagnosis
The gateway can be diagnosed by connecting the SWD-Assist software to
the Mini-USB interface. For further information, please refer to the SWD-
Assist online help.

3.5 Firmware and device description files
The EU5C-SWD-SERCOS gateway is shipped with its most recent
firmware already loaded. Which firmware version is loaded in the gateway
at the time of delivery can be inferred from the device type label (see
section Device type label [} page 29]).

The integrated WebServer of the gateway allows you to update the
firmware via Ethernet connection. For more details on this, please refer to
chapter Updating firmware  [} page 78]. 
In case of a missing or defective firmware, a firmware “recovery” process is
also possible via HTTP. Please refer to chapter Firmware recovery via
HTTP [} page 83].

Device description files (SDDML) for the gateway and the SmartWire-DT
participants (SWD slaves) are included on the product DVD in the
SDDML.zip folder in the EDS\EU5C-SWD-SERCOS\Vx.x.x.x directory.
As an alternative, you can download latest versions of the SDDML files
from our website www.hilscher.com under Products > Partner Products >
SmartWire-DT > EU5C-SWD-SERCOS > Downloads.
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4 Requirements for operation
The following prerequisites must be fulfilled to operate the EU5C-SWD-
SERCOS gateway:

4.1 Network systems
· SmartWire-DT network with maximum number of up to 99 participants/

stations/slaves and maximum extension of up to 600 meters.
· Sercos network with Sercos PLC (master device). Maximum cable

length is 100 meters.

4.2 Power supply

Danger of unsafe operation of the system
In safety-relevant applications the power supply providing power for the
SmartWire-DT system must feature a PELV power feed module (protective
extra low voltage).

Danger of unsafe operation of the system
You must take safety precautions (emergency switching off) in the external
circuitry of the gateway and any power modules type EU5C-SWD-PF1-1 or
EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power
supply to the contactor coils AUX.

Device destruction
Ensure a reliable electrical isolation of the low voltage for the 24 volt
supply. Only use power supply units complying with IEC 60364-4-41 (VDE
0100 Part 410) or HD 384.4.41 S2.

Important:
Please take into consideration the total power consumption of your
SmartWire-DT network and, if necessary, plan for an additional
feeder module EU5C-SWD-PF2. 
You can find information on the power consumption in the operating
manuals of the SmartWire-DT devices.

SmartWire-DT Gateway | EU5C-SWD-SERCOS 
DOC160805UM01EN | Revision 1 | English | 2017-02 | Released | Public

© Hilscher 2017



Requirements for operation 24/95

4.2.1 POW power connection
A Power supply of 24 V DC for the coupling unit and for the Smart-Wire-DT
slave electronics is needed at the connection POW.

On the SmartWire-DT gateway, connect the POW and AUX supply
voltages via separate miniature circuit-breakers or fuses:

Miniature circuit-breaker 24 V DC for POW
· Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN

60898:
Miniature circuit-breaker 24 V DC rated operational current 3 A; trip
types C or Fuse 3 A, utilization class gL/gG

· Cable protection for cable AWG 24 in accordance with UL 508 und
CSA-22.2 No. 14: 
Miniature circuit-breaker 24 V DC rated operational current 3 A; Tripping
characteristics C or Fuse 3 A

4.2.2 AUX power connection
If any switching devices are also to be connected, for example via the DIL-
SWD-32-001/002 SmartWire-DT slaves, a 24 V DC supply will also be
required at the AUX power connection. This provides the supply for
activating the contactor coils. This supply must be protected by an
automatic circuit-breaker (3A gG/gl or 3 A miniature circuit-breaker with a Z
characteristic). 
If switching devices with an activation power greater than 3 A are
connected, an additional feeder module EU5C-SWD-PF1 or EU5C-SWD-
PF2 must be used.

On the SmartWire-DT gateway, connect the POW and AUX supply
voltages via separate miniature circuit-breakers or fuses:

Miniature circuit-breaker 24 V DC for AUX
· Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN

60898:
Miniature circuit-breaker 24 V DC rated operational current 3 A; trip type
Z or Fuse 3 A, utilization class gL/gG

· Cable protection for cable AWG 24 in accordance with UL 508 und
CSA-22.2 No. 14: 
Miniature circuit-breaker 24 V DC rated operational current 2 A; Tripping
characteristics Z or Fuse 2 A
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5 Device picture, connectors and LEDs

5.1 Device picture

(1) 24 V power supply POW
(2) Sercos interface (RJ45)
(3) LEDs Sercos bus status 

(see subsequent section for details)
(4) Mini-USB interface
(5) Configuration button
(6) LEDs indicating gateway functions

(see subsequent section for details)
(7) 24 V power supply AUX
(8) SmartWire-DT connection 

(plug, 8-pole)

Table 11: Front view EU5C-SWD-SERCOS gateway
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5.2 Positions and descriptions of the LEDs

5.2.1 Positions of the LEDs
(1) POW: System status
(2) APL: Application status
(3) Config.: Configuration status
(4) SWD: SmartWire-DT status
(5) S: Sercos bus status
(6) not used
(7) L/A: LINK/Activity for channel 0
(8) Receive/Transmit (RX/TX) for channel 0
(9) L/A: LINK/Activity for channel 1
(10) Receive/Transmit (RX/TX) for channel 1

Table 12: LEDs EU5C-SWD-SERCOS Gateway

5.2.2 Description of the LEDs

Gateway function LEDs
LED Color State Meaning
POW 
System status
Number in
picture: 
(1)

Duo LED yellow/green

 (yellow) On Operating system running, firmware has been started.

 
(green/
yellow)

Blinking green/
yellow

Second Stage Bootloader is not able to load the firmware.
The device needs to be sent-in for servicing.

(green)
On Backup firmware is active.

The gateway needs a firmware recovery as described in chapter
Firmware recovery via HTTP [} page 83].

(green)
Blinking green ROM loader is not able to find bootable image.

The device needs to be sent-in for servicing.

 (off) Off Power supply for device is missing or hardware is defect.
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LED Color State Meaning
APL 
Application
status
Number in
picture: 
(2)

Duo LED red/green

(green)
On Communication on Sercos and SmartWire-DT is in cyclic data

exchange and the gateway function is executed.

(green)
Blinking
1 s off, 
1 s on

Gateway is initialized, but the communication on Sercos or
SmartWire-DT is not in cyclic data exchange.

(red)
Blinking
1 s off, 
1 s on

Gateway is initialized, but the SmartWire-DT configuration is missing
or in error.

(red)
On Gateway has detected an error during the initialization: Missing

configuration, error in configuration or internal error.

Config. 
Configuration
status
Number in
picture: 
(3)

Duo LED red/green

(green)
On The project configuration complies with the target configuration. 

Data exchange between gateway and PLC via Sercos is possible.

(green)
Blinking The project configuration does not comply with the target

configuration, but is compatible with it. Data exchange between
gateway and PLC via Sercos is possible.

(red)
On The project configuration and the target configuration are not

compatible. Data exchange between gateway and PLC via Sercos is
not possible.

(off)
Off No communication with the Sercos PLC or the gateway does not

have a project configuration.

SWD 
SmartWire-DT
status
Number in
picture: 
(4)

Duo LED red/green/orange (orange = red/green at the same time)

(green)
On The actual configuration complies with the target configuration. Data

exchange between gateway and SmartWire-DT slaves takes place.

(red)
Blinking The gateway misses its target configuration or a necessary

SmartWire-DT slave is missing or the target configuration does not
comply with the actual configuration.
No data exchange between gateway and SmartWire-DT slaves.

(green)
Blinking Slave addressing is active (after power-on or download of a project

configuration containing empty modules). 
No data exchange between gateway and SmartWire-DT slaves.

(red)
On Short-circuit on the 15 V power supply or no SmartWire-DT slave is

connected. 
No data exchange between gateway and SmartWire-DT slaves.

(orange)
Blinking After having pressed the configuration button: The gateway reads

the actual configuration and stores it as target configuration.

Table 13: Description of the Gateway function LEDs
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Sercos LEDs
LED Color State Meaning
S
Number in picture: (5)

Duo-LED red/green (orange = red/green simultaneously)

 (green) On CP4: Communication phase 4: Normal operation, no error

 (green) Flashing 
(2 Hz)

Loopback: The network state has changed from „fast-forward“ to
„loopback“.

 
(green/
orange)

Flashing
(3 x green/3s)

CP3: Communication phase 3

(2 x green/3s) CP2: Communication phase 2
(1 x green/3s) CP1: Communication phase 1

(orange)
On CP0: Communication phase 0

 
(orange/
green)

Flashing 
(2 Hz)

HP0: Hot-plug phase 0

(1 x orange/3s) HP1: Hot-plug mode phase 1
(2 x orange/3s) HP2: Hot-plug mode phase 2

(orange)
Flashing 
(2 Hz)

Identification: Corresponds to C-DEV.Bit 15 in the Slave’s
Device Control indicating remote address allocation or
configuration errors between Master and Slaves.

 
(green/red)

Flashing 
(2 Hz, min. 2s)

MST losses ≥ (S-0-1003/2): Depends on IDN S-0-1003.
Corresponds to S-DEV.Bit 15 in the Device Status indicating a
communication warning (Master SYNC telegrams have not been
received).

  
(red/
orange)

Flashing 
(2 Hz)

Application error (C1D): See GDP & FSP Status codes class
error.

 (red) Flashing 
(2 Hz)

Watchdog error: Application is not running

 (red) On Communication Error (C1D): Error detected according to Sercos
third generation Class 1 Diagnosis, see SCP Status codes class
error.

 (off) Off NRT-Mode: (Non Real-Time Mode) No Sercos Communication

Number in picture: (6) Duo LED red/green

 (off) Off This LED is not used.

L/A
Number in picture: 
Ch0: (7) 
Ch1: (9)

LED green

 (green) On Link: The device is linked to the Ethernet, but does not send/
receive Ethernet frames.

 (green) Flickering (load
dependent)

Activity: The device is linked to the Ethernet and sends/receives
Ethernet frames.

 (off) Off The device has no link to the Ethernet.

Number in picture: 
Ch0: (8) 
Ch1: (10)

LED yellow

 (off) Off This LED is not used.

Table 14: LED states for the Sercos Slave protocol
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5.3 Pinning of the Real-Time Ethernet interface
The following picture shows the pinning of the Sercos interface of the
gateway.

Figure 2: Pinning of the Ethernet interface (RJ45)

Pin Signal Description
1 TX + Transmit Data +
2 TX – Transmit Data –
3 RX + Receive Data +
4 TERM Bob Smith Termination
5 TERM
6 RX – Receive Data –
7 TERM Bob Smith Termination
8 TERM

Table 15: Ethernet interface channel 0 and channel 1 pin assignment (RJ45)

Note:
The Ethernet interface supports auto crossover.

5.4 Device type label
The EU5C-SWD-SERCOS Gateway is equipped with a device type label,
which provides the following information:

(1) Version of firmware (at time of delivery)
(2) Information on power supply for switching devices (AUX)
(3) Information on power supply for Gateway and Smart-

Wire-DT slaves (POW)
(4) Information on wire gauge of power supplies
(5) Operating ambient temperature
(6) Device type name
(7) Part number
(8) Hardware revision number
(9) Serial number

Table 16: Device type label EU5C-SWD-SERCOS Gateway
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6 Getting started
The following table provides an overview of the steps necessary for
installing and commissioning the EU5C-SWD-SERCOS Gateway.

# Step For details see
1 Install gateway Chapter Installing gateway [} page 31]
1.1 Take safety precautions Section Safety messages [} page 31]
1.2 Mount gateway onto top hat rail Section Mounting gateway  [} page 32]
1.3 Connect gateway to power supply Section Connecting gateway to power

supply [} page 34]
1.4 Connect gateway to SmartWire-DT network Section Connecting SmartWire-DT  [} page 36]
1.5 Connect gateway to Sercos network Section Connecting Sercos [} page 37]
2 Configure gateway Chapter Configuring gateway [} page 38]
2.1 Configure SmartWire-DT network in gateway Section Configuring SmartWire-DT network in

gateway (creating target
configuration) [} page 38]

2.2 Configure gateway in Sercos with IndraWorks Section Configuring gateway in
Sercos [} page 40]

3 Parameterize SmartWire-DT in IndraWorks Chapter Parameterization [} page 49]
3.1 Configure gateway as SmartWire-DT Coordinator 

(if other than default settings are going to be used)
Section Configuring EU5C-SWD-SERCOS
gateway as SmartWire-DT
Coordinator [} page 49]

3.2 Configure device options and parameters of SmartWire-
DT slaves (if other than default settings are to be used)

Section Configuring options and parameters of
SmartWire-DT devices [} page 51]

Table 17: Getting started
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7 Installing gateway

7.1 Safety messages

Electrical shock
Please observe the following safety messages when you install and handle
the gateway:
Ø First disconnect the power plug of the device.
Ø Make sure that the power supply is off at the device.
Ø Cover or enclose neighboring units that are live.

Electrostatic Sensitive Device
The gateway is sensitive to electrostatic discharge, which can cause
internal damage and affect its normal operation. Therefore adhere to the
necessary safety precautions for components that are vulnerable to
electrostatic discharge, when you install or handle the gateway:
Ø Do not touch the metal pins of the connectors of the gateway.
Ø Touch a grounded object to discharge potential static.
Ø Wear an approved grounding wrist strap.
Ø If available, use a static-safe workstation.
Ø When not in use, store the device in an appropriate static-safe

packaging.
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7.2 Mounting gateway
No tools are required for mounting the EU5C-SWD-ETHERCAT Gateway
onto a top hat rail. The back of the gateway (1) carries a spring-fitted bolt
(2) by which the gateway can be clamped to the rail (3).

Figure 3: Mounting principle of the gateway

7.2.1 Mounting gateway onto top hat rail
To mount the gateway onto the top hat rail, proceed as follows:

 Electrical shock: Make sure that the gateway is disconnected
from any power supply! Cover or enclose neighboring units that are live!
Ø Tilt the gateway slightly and hook it into the upper

railing from above, thereby pushing down the
gateway with slight force, in order to overcome the
resistance of the spring in the bolt.

Hook gateway to upper railing
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Ø Keep on pushing the gateway downwards and tilt it
back into vertical position, thereby hooking the
gateway into the lower railing.

Hook gateway to lower railing

Ø Let go of the gateway. The spring inside the bolt
automatically pushes the gateway upwards into
the railings, thereby fixing the gateway to the top
hat rail.

Gateway is clamped to top hat rail
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7.2.2 Removing gateway from top hat rail
To remove the gateway from the top hat rail, proceed as follows:

 Electrical shock: Make sure that the gateway is disconnected
from any power supply! Cover or enclose neighboring units that are live!
Ø Push down the gateway with slight force (to

overcome the resistance of the spring in the bolt),
then unhook the gateway first from the lower railing
and then from the upper railing.

Unhook gateway

7.3 Connecting gateway to power supply

Danger of lethal injuries by unexpected starting up of motors or
machinery!
If you have already integrated devices into a system, secure the operating
range of any connected parts of the system against access, so that nobody
is endangered by motors or machinery starting up unexpectedly.

Danger of unsafe operation of the system
In safety-relevant applications the power supply providing power for the
SmartWire-DT system must feature a PELV power feed module (protective
extra low voltage).

Danger of unsafe operation of the system
You must take safety precautions (emergency switching off) in the external
circuitry of the gateway and any power modules type EU5C-SWD-PF1-1 or
EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power
supply to the contactor coils AUX.
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Important:
Please take into consideration the total power consumption of your
SmartWire-DT network and, if necessary, plan for an additional
feeder module EU5C-SWD-PF2. You can find information on the
power consumption in the operating manuals of the SmartWire-DT
devices.

Ø Connect the 24 V DC voltage to the POW terminals on the front side of
the gateway. The POW connection provides the voltage for the gateway
itself and for the SmartWire-DT slave electronics.

Note:
For the 15 V supply of the SmartWire-DT slaves, the gateway
contains an additional power feed module with an amperage of
0.7 A.

Ø If necessary, connect the 24 V DC voltage for the contactor coils to the
AUX terminals on the front side of the gateway.

Figure 4: Gateway power supply

Note:
The AUX supply is required if any switching devices are also to be
connected, for example, via the DIL-SWD-32-001/002 SmartWire-
DT slaves. The AUX connection provides the supply for activating
the contactor coils.
This supply must be protected by an automatic circuit-breaker (3A
gG/gl or 3 A miniature circuit-breaker with a Z characteristic).
If switching devices with an activation power greater than 3 A are
connected, an additional feeder module EU5C-SWD-PF1 or EU5C-
SWD-PF2 must be used.
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Potential conditions between the components

The entire SmartWire-DT system operates on a common supply voltage.
Provide a common star point for the earth wiring. In this way, the various
slaves in the SmartWire-DT system will not be electrically isolated from one
another. 
The Sercos network and the SmartWire-DT system are electrically isolated
from one another.

7.4 Connecting SmartWire-DT
Ø Connect the SmartWire-DT network to the gateway. To do so, use the

SmartWire-DT cable SWD4-100LF8-24 and the SWD4-8MF2 relevant
blade terminal or prefabricated cables of type SWD4-(3/5/10)F8-24-2S.

Figure 5: Connecting SmartWire-DT to gateway

Device destruction
Switch off the power supply before you are reconnecting slaves in the
SmartWire-DT system or reconnecting the ribbon cable connection.
Otherwise the SmartWire-DT slaves can be destroyed!

Detailed instructions on adapting the SmartWire-DT external device
plug (SWD4-8SF2-5) to the 8 pole Smart-Wire-DT cable are
provided in chapter Fitting external device plugs SWD4-8SF2-5 of
the manual SmartWire-DT – The System, MN05006002Z-EN
(previously AWB2723-1617en).
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7.5 Connecting Sercos
Ø Connect the RJ45 plug of the Sercos cable to one of the Ethernet

connectors on the gateway.

Figure 6: Connecting Sercos to gateway

Important:
Please observe the following notes on Sercos cabling :
Ø Use only hubs, no switches.
Ø Use shielded Ethernet cables that meet the requirements of at

least category 5 (Cat5) according to EN 50173 or ISO/IEC
11801.

Ø Maximum cable length in a segment (allowed space between
individual devices/hub) is 100 meters.

7.6 EMC-conformant wiring of the network
Undesired faults can occur on the bus due to electromagnetic interference. 
This can be minimized beforehand by the implementation of suitable EMC
measures. These include:
· EMC-conformant system configuration,
· EMC compliant cable routing,
· Measures that do not allow the occurrence of large differences in

potential and
· correct installation of the Sercos system (cables, connection of the bus

connectors, etc.)

For more detailed information on this, please refer to the IAONA
Industrial Ethernet -Planning and Installation Guide by IAONA e.V.
Magdeburg, Germany.
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8 Configuring gateway

8.1 Overview
For data exchange between the gateway and the Sercos master, the
gateway needs a valid target configuration and a valid project configuration.
The target configuration of the SmartWire-DT network can be created and
stored in the gateway by using the configuration button on the gateway
device. The project configuration must be created and transferred to the
gateway by means of the Sercos engineering tool (i. e. IndraWorks®). 
This chapter describes how to create and store these configurations in the
gateway.

8.2 Configuring SmartWire-DT network in gateway (creating
target configuration)

8.2.1 Overview
When you commission the gateway, you have to read-in the actual
configuration of the SmartWire-DT network (i. e. the line-up of the
participants/devices connected to the SWD bus) and store it as target
configuration.

Reading and storing the SmartWire-DT network configuration takes place
by pressing the configuration button on the gateway (for the position of the
configuration button, see figure Device picture [} page 25]). All SmartWire-
DT slaves are re-addressed in ascending order by this process.

This process should only take place in the case of:
· initial commissioning,
· replacement of a defective slave or
· deliberate change to the configuration.

Hazard of device damage by disruption of voltage supply while
creating target configuration!
Do not interrupt the voltage supply while creating the target configuration of
the gateway. Power failure during a writing process within the file system
can cause severe malfunctioning of the device.

Important:
If there is a faulty configuration and the configuration button is
pressed, only the slaves up to the failed device are addressed and
stored. Use of the remaining slaves is not possible until the
defective slave has been replaced and the configuration has been
read-in again by pressing the configuration button.
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The remanently stored target configuration is compared with the current
configuration (actual configuration) each time the gateway is restarted and
during bus operation. If the gateway recognizes that a required SmartWire-
DT slave cannot be reached or a wrong slave type is determined, the
gateway will not go into operation or stops operating. This depends in each
case on the setup of the network which has been defined in the planned/
project configuration. In case of error, the SmartWire-DT status LED (SWD
LED) starts to blink in red (for the position of the SWD LED, see section
Positions of the LEDs [} page 26]).

If a SmartWire-DT slave has failed, the SmartWire-DT network can still be
operated with the remaining slaves, depending on the settings in the
planned/project configuration (even after a repeated power up of the
gateway). The failure is reported to the application.

8.2.2 Prerequisites
Prerequisites for reading-in the SmartWire-DT configuration are:
· All SmartWire-DT slaves are connected to the SmartWire-DT line.
· The SmartWire-DT status LEDs of the individual SmartWire-DT slaves

are on or are flashing.
· The SmartWire-DT network is connected to the gateway.
· The voltage POW is applied to the gateway and the power POW LED is

on.
· The voltage AUX is applied (if necessary).

8.2.3 Step-by-step instructions
To read-in the SmartWire-DT configuration, proceed as follows:
Ø Press the configuration button on the gateway for at least two seconds

(for the position of the configuration button, see figure in section Device
picture [} page 25]).

Note:
Take care to push-in the button properly. You have to feel and
overcome a slight resistance at the end when pushing the button
into the gateway, otherwise the button will not trigger.

Ê The SmartWire-DT status LED (SWD LED) on the gateway begins to
flash orange. The SmartWire-DT status LEDs on the SmartWire-DT
slaves also flash. All slaves are addressed in sequence, the complete
configuration is stored retentively as gateway target configuration.

Hazard of device damage by disruption of voltage supply while
creating target configuration!
Do not interrupt the voltage supply while creating the target configuration of
the gateway. Power failure during a writing process within the file system
can cause severe malfunctioning of the device.
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Ê The SmartWire-DT status LED (SWD LED) on the gateway shows
steady green.

Note:
As an alternative, you can generate and store the target
configuration by using the SWD-Assist software. For this, the
gateway must be connected to SWD-Assist via USB. For details,
please refer to the SWD-Assist online help.

8.3 Configuring gateway in Sercos

8.3.1 Device description files
The EU5C-SWD-SERCOS Gateway is integrated as slave in the Sercos
network. Configuring the gateway and the SmartWire-DT devices in the
Sercos engineering tool requires SDDML device description files in XML
format containing standardized descriptions of the gateway and the
SmartWire devices.

You will find the device description files on the product DVD in the
SDDML.zip folder in the EDS\EU5C-SWD-SERCOS\Vx.x.x.x directory.
You can also download the latest versions of the files from our website
www.hilscher.com under Products > Partner Products > SmartWire-DT >
EU5C-SWD-SERCOS > Downloads.

Unpack the SDDML.zip folder, then import the files into the IndraWorks
engineering tool as described in the following section.

Important:
Please note that data exchange between the gateway and the
Sercos network can only take place after a SmartWire-DT network
has been connected and configured in the gateway (see section
Configuring SmartWire-DT network in gateway (creating target
configuration) [} page 38]).
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8.3.2 Configuring gateway in IndraWorks

8.3.2.1 Overview

This section describes how to create the project configuration for the
EU5C-SWD-SERCOS gateway by using the IndraWorks® ML 14V10 P2
engineering tool.

8.3.2.2 Prerequisites
· PC with installed IndraWorks engineering tool
· You have access to the SmartWire-DT Gateway Solutions DVD (or

you have downloaded the device description files from our website)
· You need an unpacking program like 7-Zip to unpack the device

description files from the SDDML.zip archive folder before importing
them into IndraWorks

8.3.2.3 Adding gateway and SmartWire-DT devices to Sercos bus
1. Unpack ZIP folder and device description files.

Ø On the product DVD, open EDS\EU5C-SWD-SERCOS\Vx.x.x.x
directory.

Ø Use an appropriate archive tool like e. g. 7-Zip to unpack the
SDDML.zip folder.

2. Import device description files into IndraWorks.
Ø Open IndraWorks on your engineering PC.
Ø In the menu bar of IndraWorks, select Tools > Device Database...
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Ê The Device Database dialog window opens:

Figure 7: Device Database dialog window in IndraWorks

Ø Click Add Devices...
Ê The Install Device Descriptions window opens.
Ø In the Install Device Descriptions window, navigate to the folder

containing the unpacked device description files (SDDML).
Ø Select all device description files, then click Open.

Note:
If you know exactly which SmartWire-DT devices you are using in
your SmartWire-DT network (and thus which device description files
you need to import), you can confine your selection to the
corresponding XML files. 
However, in any case make sure to import the gateway file
SDDML#v3.1#Hilscher#EU5C-SWD-SERCOS#xxxx-xx-
xx.xml.
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Ê The Install Device Descriptions window closes and the files are being
imported. The imported files and their paths are listed in the bottom field
of Device Database dialog window:

Figure 8: Imported SDDML files

Ø In the Device Database dialog window, select Close.
Ê The Device Database dialog window closes. You can display the

imported device description files in the Library area of IndraWorks
under Periphery > Sercos:

Figure 9: Imported SDDML files in Library of IndraWorks
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3. Open existing project or create new project.
Ø If you want to integrate the gateway into an already existing project,

open this project.
Ø If you want to create a new project, choose File > New > Project... from

the menu.
Ê The Create new project dialog window opens:

Figure 10: Create new project dialog window

Ø Enter the parameters of your project, then click OK.
Ê The Create new project dialog window closes and the new project is

displayed in the Project Explorer.
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4. Add Sercos master to project.
Ø If your project does not feature a Sercos master yet, choose Project >

Add from the menu, then select the appropriate master device, e. g.
IndraMotion MLC > IndraControl L65.

Figure 11: Add Sercos master to project

Ê A wizard for configuring the master/controller opens:

Figure 12: Wizard for configuring controller
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Ø Use the wizard to configure the Sercos master/controller.

For further information please refer to the online help of IndraWorks.

5. Add EU5C-SWD-SERCOS gateway as Sercos slave to the project.
Ø In the Project Explorer, select the Sercos object below the Sercos

master (in this example the Sercos master is IndraMotion Mlc1), then
choose Add > EU5C-SWD-SERCOS from the context menu:

Figure 13: Add gateway to project

Note:
As an alternative, you can select the gateway in the Library under
Periphery > Sercos and then drag & drop it onto the Sercos object
in the Project Explorer. By using this drag & drop method, you can
also place the gateway exactly between two already existing Sercos
slaves.
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Ê The gateway is displayed as Sercos slave (1) below the Sercos object
in the Project Explorer. 
Below the gateway object, a second entry (2) symbolizes the gateway
as Sercos module (this is the gateway in its role as SmartWire-DT
Coordinator or “head station” of the subordinate SmartWire-DT
participants, see section Configuring EU5C-SWD-SERCOS gateway as
SmartWire-DT Coordinator [} page 49] for more information on this).

Figure 14: Gateway added as Sercos slave

6. Configure gateway as Sercos slave if necessary.
Ø In the Project Explorer, double-click EU5C_SWD_SERCOS object to

open an editor in which you can configure the gateway as Sercos slave.

Figure 15: Sercos slave editor
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7. Add SmartWire-DT participants (SWD device) to the project.
Ø In the Project Explorer, select EU5C_SWD_SERCOS object, then

choose Add > Module from the context menu and select the
SmartWire-DT device you want to add to the project.
(As an alternative, you can select the SWD device in the Library under
Periphery > Sercos > EU5C-SWD-SERCOS and then drag & drop it
onto the EU5C_SWD_SERCOS object in the Project Explorer.)

Figure 16: Add SmartWire-DT device as Sercos module to the project

Ø Add all SmartWire-DT devices which are part of your (secondary)
SmartWire-DT network to the Sercos project in the manner described
above.
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9 Parameterization

9.1 Configuring EU5C-SWD-SERCOS gateway as SmartWire-DT
Coordinator

Being the master device in the SmartWire-DT network, the EU5C-SWD-
SERCOS gateway serves as a so-called “Coordinator” controlling the data
transfer procedure within the SmartWire-DT network in accordance with the
SmartWire-DT protocol. Via the Coordinator, you can configure the
following properties:
· the Baud rate of the SmartWire-DT network (Baudrate)
· the handling of failing SmartWire-DT devices (All Modules Optional)
· the handling of the replacement of SmartWire-DT devices during bus

operation (Replace Mode)

To configure the Coordinator parameters in IndraWorks® proceed as
follows:
Ø In the Project Explorer double-click EU5C_SWD_SERCOS_1 (EU5C-

SWD-SERCOS) object.

Figure 17: Configuring Coordinator parameters

Ê In the workspace area (middle of the window), the editor for the Sercos
module opens.

Ø Select User Parameter tab.
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Ø To change a Coordinator parameter, double-click the field you want to
edit in the Value column, then click the small black triangle to open a
drop-down list containing the optional values:

Figure 18: Changing Coordinator parameters

You can set the following parameters:
Parameter Description Value Descriptions of the Values
Baudrate SWD Baud rate 125 kBit/s (Default) Baud rate of the SmartWire-DT network

250 kBit/s
All Modules Optional Allows individual

configuration
whether a
SmartWire-DT
device can be
missing or not

No You can configure for each SmartWire-DT
device individually in its Presence
parameter, whether it is allowed to be
missing or not. (Default)
(See also section Configuring options and
parameters of SmartWire-DT
devices [} page 51])

Yes Data exchange with the Sercos master takes
place even if there is a random number of
missing devices in the SmartWire-DT
network. The corresponding settings in the
device options of the individual SmartWire-
DT device thus have no effect and will be
overruled.

Replace Mode Online replacement
of SmartWire-DT
devices during bus
operation is allowed

No Online replacement is not allowed; new
SmartWire-DT devices must always be read
into the SWD configuration by pushing the
configuration button. (Default)

Yes Allows online replacement of SmartWire-DT
devices during bus operation without having
to push the configuration button afterwards
in order to read them into the SWD
configuration.

Note: If this parameter is set to Yes, the All Modules Optional
parameter must also be set to Yes, otherwise the whole SWD bus
will be turned off after losing communication with one or several
SWD devices. 
Please note also that online replacement during bus operation is
only possible if SWD4-FFR-PF/ST…. power supply module/cable
adapters are being used. Otherwise replacement must take place
while power is switched off at the gateway. After return of voltage
supply, the network will automatically be reconfigured (without
having to push the configuration button).

Table 18: Coordinator parameters
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9.2 Configuring options and parameters of SmartWire-DT devices
You can configure certain options and parameters of individual SmartWire-
DT devices. For example, you can determine for each device individually
whether its presence in the SmartWire-DT network is mandatory or whether
it may be substituted by a universal module. For a couple of I/O modules,
you can also configure typical parameters like sensor types or refresh
rates.

Configurable parameters of the SmartWire-DT devices are
described in the manual SmartWire-DT Modules, Doc ID
MN05006001Z-EN, which is stored on the product DVD in the
directory Documentation\english\3.SmartWire-DT
\SmartWire-DT – Units\MN05006001Z_EN.pdf

To configure a SmartWire-DT device in IndraWorks® proceed as follows:
Ø In the Project Explorer, double-click the SmartWire-DT device you

want to configure (in this example the EU5C_SWD_2A2A object).
Ê The Sercos module editor opens in the working area.
Ø Select User Parameter tab.

Figure 19: Configure device parameters
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Ø To change a device parameter, double-click the field you want to edit in
the Value column, then click the small black triangle to open a drop-
down list containing the optional values:

Figure 20: Change device parameter values

The following table shows the parameters of the EU5C-SWD-2A2A IO
module. Note that the device option Presence is a feature of all SmartWire-
DT devices; the other parameters listed here are specific to the EU5C-
SWD-2A2A module, which means that other SmartWire-DT may have
different parameters.

Individual parameters of SmartWire-DT devices are described in the
manual SmartWire-DT Modules, Doc ID MN05006001Z-EN, which
is stored on the product DVD in the directory Documentation
\english\3.SmartWire-DT\SmartWire-DT – Units
\MN05006001Z_EN.pdf
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Parameter Description Value Descriptions of the values
Presence Presence in

SmartWire-DT network
Device shall be
present

Device must be present in current SmartWire-DT bus
configuration (default)

Device may be not
present

Device may be absent in current SWD bus
configuration

Type of sensor
input 0

Sensor selector (signal
range) input 0

Voltage (0-10V) Voltage sensor (0-10 V) (default)
Current (0-20mA) Current sensor (0-20 mA)

Type of sensor
input 1

Sensor selector (signal
range) input 1

Voltage (0-10V) Voltage sensor (0-10 V) (default)
Current (0-20mA) Current sensor (0-20 mA)

Type of actuator
output 0

Actuator selector
(signal range) output 0

Voltage (0-10V) Voltage (0-10 V) (default)
Current (0-20mA) Current (0-20 mA)

Type of actuator
output 1

Actuator selector
(signal range) output 1

Voltage (0-10V) Voltage (0-10 V) (default)
Current (0-20mA) Current (0-20 mA)

Measurement
update time

Refresh rate of
measured value

20 ms
100 ms (default)
200 ms
500 ms

Refresh rate of measured values to SmartWire-DT
network in milliseconds

Averaging Mean value function On Averaging function to smooth out input signal
fluctuations (default)

Off No averaging
Table 19: Configurable device options and parameters of SWD slave (EU5C-SWD-2A2A
example)
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10 Acyclical communication

10.1 Overview
The Sercos master can exchange acyclic data with individual SmartWire-
DT slaves via the gateway by using the following IDNs:
P-0-2000.[x].1 
P-0-2000.[x].2 
P-0-2000.[x].3 (Procedure Command). 
[x] represents the address of the concerned SmartWire-DT slave within
the SWD network.

Note:
For acyclic data exchange with the SmartWire-DT slaves, the
gateway must be in communication phase 4 (CP4).

The subsequent section describes a typical acyclic communication process
(see also diagram on the following page):
1. The Sercos master writes a task (read or write request) for a

SmartWire-DT slave into the IDN P-0-2000.[x].1
2. The tasks is activated by the procedure command IDN P-0-2000.

[x].3

3. The gateway forwards the task to the SWD slave. The SWD slave
executes the requested read or write task in the specified SWD Index.

4. The answer from the SWD slave arrives at the gateway and is written to
the IDN P-0-2000.[x].2. 
The gateway reports successful execution of the procedure command.

5. The Sercos master can now read the response from the IDN
P-0-2000.[x].2
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Figure 21: Acyclic communication
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10.2 Read request: reading data of an SWD Slave

10.2.1 Overview: read request

Configuring read request

A reading task (read request) for a SmartWire-DT slave is written into the
IDN P-0-2000.[x].1 by the Sercos master, whereby [x] is representing
the address of the concerned SWD slave. 
The IDN contains the following elements:
Element Description Data type Value / value

range
SWD Index SWD-specific index of the SWD slave.

Determines which kind of data you want to
read, e. g. error counter

uint8 0…255

Request
Type

Type of request. A read request must have the
value 0

uint8 0

Length Maximum length of the expected response in
bytes. Must be at least as long as the SWD
object (in bytes)

uint8 1…120

Table 20: Elements of IDN P-0-2000.x.1 for read request

Activating read request

After having configured the read request, the Sercos master uses the
procedure command IDN P-0-2000.[x].3 to activate the task, whereby
[x] is representing the address of the concerned SWD slave.

Reading response of read request

After the procedure command has been completed, the Sercos master can
read the response from the IDN P-0-2000.[x].2, whereby [x] is
representing the address of the concerned SWD slave. 
The IDN contains the following elements:

Element Description Data type Value / value range
SWD Index SWD index of the data which has been read, e. g.

error counter
uint8 0…255

Request Type Type of request. 
A read request has the value 0

uint8 0

Length Length of the received response (payload data) in
bytes

uint8 1…120

Result State of response uint32 0x00000000 = no error

0xC0AD0002 =
JOBID_BUFFER_FULL (buffer for
acyclic tasks is full)
0xC0AD0003 = JOB_DENIED
(task denied)
0xC0AD0004 = NOT_AVAILABLE
(SWD slave is not available)

Data Payload data which has been read according to
SWD Index, e. g. error counter

uint8 [n-1] * (…)

* n = amount of read bytes
Table 21: Elements of IDN P-0-2000.x.2
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10.2.2 Read request example
The following step-by-step instructions show how to read the error counter
of SmartWire-DT slave #1 by using the IndraWorks®  ML 14V10 P2
engineering tool.
· SWD Index of error counter: 127 (hex: 0x7F)

· Request type for reading task: 0 (hex: 0x00)

· Maximum length of expected response in bytes: 120 (hex: 0x78)

Prerequisites
· You are connected and logged-in at the Sercos PLC/Master via

IndraWorks.
· The gateway is connected to the Sercos PLC/Master and is in

communication phase 4 (CP4).

Step-by-step instructions
1. Open parameter editor.

Ø In the Project Explorer, select the gateway then click the  parameter
editor symbol in the tool bar.

Figure 22: Open parameter editor

Ê The parameter editor opens.
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2. Configure read request.
Ø In the IDN field, enter S-0-2000.1.1 then press Enter on your

keyboard.
Ø Enter SWD Index in field 0, Request Type in field 1 and the length of the

expected response in field 2:

Figure 23: Configure read request

Ø Press Enter on your keyboard.

3. Activate read request.
Ø In the IDN field, enter S-0-2000.1.3 then press Enter on your

keyboard.
Ø In the Value field, set the last two digits to 11.

Figure 24: Activate read request

Ø Press Enter on your keyboard to issue this procedure command and
thus activate the read request on the gateway.
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4. View response of read request.
Ø In the IDN field, enter S-0-2000.1.2 then press Enter on your

keyboard to view the response of the read request:

Figure 25: View response

Field 0: SWD Index

Field 1: Request Type

Field 2: Length

Feld 3…6: Result

Feld 7...n: Data
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10.3 Write request: writing data to an SWD Slave

10.3.1 Overview write request

Configuring write request

A writing task (write request) for a SmartWire-DT slave is written into the
IDN P-0-2000.[x].1 by the Sercos master, whereby [x] is representing
the address of the concerned SWD slave. 
The IDN contains the following elements:
Element Description Data type Value / value

range
SWD Index SWD-specific index of the SWD slave.

Determines where to write the data to, e. g.
error counter

uint8 0…255

Request Type Type of request. A write request must have
value 1

uint8 1

Length Length of the data (in bytes) to be written uint8 1…120

Data Data to be written uint8 [n-1] * (…)
* n = amount of bytes to be
written

Table 22: Elements of IDN P-0-2000.[x].1 for write request

Activating write request

After having configured the write request, the Sercos master uses the
procedure command IDN P-0-2000.[x].3 to activate the task, whereby
[x] is representing the address of the concerned SWD slave.

Reading result of write request

After the procedure command has been completed, the Sercos master can
read the result from the IDN P-0-2000.[x].2, whereby [x] is
representing the address of the concerned SWD slave. 
The IDN contains the following elements:

Element Description Data type Value / value range
SWD Index SWD index of the data which has been written, e. g.

error counter
uint8 0…255

Request Type Type of request. A write request has value 1 uint8 1

Length Length of the received response (payload data) in
bytes. Has value 0 in a write request

uint8 0

Result State of request uint32 0x00000000 = no error

0xC0AD0002 =
JOBID_BUFFER_FULL (buffer
for acyclic tasks is full)
0xC0AD0003 = JOB_DENIED
(task denied)
0xC0AD0004 =
NOT_AVAILABLE (SWD slave
is not available)

Table 23: Elements of IDN P-0-2000.[x].2 for write request
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10.3.2 Write request example
The following step-by-step instructions show how to reset the error counter
of SWD slave #1 to value 0 by using the IndraWorks®  ML 14V10 P2
engineering tool.
· SWD Index of error counter: 127 (hex: 0x7F)

· Request type for writing task: 1 (hex: 0x01)

· Length of data to be written in bytes: 1 (hex: 0x01)

· Data (value) to be written: 0 (hex: 0x00)

Prerequisites
· You are connected and logged-in at the Sercos PLC/Master via

IndraWorks.
· The gateway is connected to the Sercos PLC/Master and is in

communication phase 4 (CP4).

Step-by-step instructions
1. Open parameter editor.

Ø In the Project Explorer, select the gateway then click  parameter
editor symbol in the tool bar.

Figure 26: Open parameter editor

Ê The parameter editor opens.
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2. Configure write request.
Ø In the IDN field, enter S-0-2000.1.1 then press Enter on your

keyboard.
Ø Enter SWD Index in field 0, Request Type in field 1, length in field 2 and

the data to be written (the reset-value) in field 3:

Figure 27: Configure write request

Ø Press Enter on your keyboard.

3. Activate write request.
Ø In the IDN field, enter S-0-2000.1.3 then press Enter on your

keyboard.
Ø In the Value field, set the last two digits to 11.

Figure 28: Activate write request

Ø Press Enter on your keyboard to issue this procedure command and
thus activate the write request on the gateway.
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4. View result of write request.
Ø In the IDN field, enter S-0-2000.1.2 then press Enter on your

keyboard to view the result of the write request:

Figure 29: View result of write request

Field 0: SWD Index

Field 1: Request Type

Field 2: Length

Field 3: Result
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11 Diagnosis

11.1 Overview
The gateway reports errors/warnings concerning the gateway, concerning
the state of the SmartWire-DT network or concerning individual SmartWire-
DT slaves by means of “standard” Sercos diagnostic IDNs:

S-0-0390.0.0 (Diagnostic Number)

S-0-0095.0.0 (Diagnostic Message)

S-0-1500.0.32 (IO Diagnostic Message)

S-0-0390.0.0 (Diagnostic Number)

This IDN contains the newest reported diagnosis. The uint32 value is coded
as follows:

Bit Element Value / value range Meaning
31 ... 30 Interpretation of bits 29 ... 0 0x00 Bits 29...16 (Source Type and Diagnosis Class) are

defined by Sercos.
Bits 15...0 (Status Code) are defined by manufacturer.

29 ... 24 Source Type 0x01 FSP IO (further details available in IO Diagnostic
message)

23 ... 20 Reserved - -
19 ... 16 Diagnosis Class 0x0E Warning (C2D)

(see section Diagnosis messages of individual SWD
slaves (Diagnosis Class = Warning) [} page 66])

0x0F Error (C1D)
(see section Diagnosis messages generated by the
gateway (Diagnosis Class = Error) [} page 70])

15 ... 0 Status Code 0x0000 ... 0xFFFF In case of Diagnosis Class = 0x0E (warning), this is
the SWD-specific Diagnosis Code of the concerned
SWD device.
In case of Diagnosis Class = 0x0F (error), see table
Diagnosis Codes of the Gateway in section Diagnosis
messages generated by the gateway (Diagnosis Class
= Error) [} page 70].

Table 24: Coding of Diagnostic Number

S-0-0095.0.0 (Diagnostic Message)

This IDN contains a descriptive statement (e. g. Mandatory SmartWire-
DT module missing) related to the diagnostic number reported in IDN
S-0-0390.0.0.
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S-0-1500.0.32 (IO Diagnostic Message)

This IDN contains additional information related to the diagnostic number
reported in IDN S-0-0390.0.0. The uint64 value is coded as follows:

Bit Element Value / value range Meaning
63 Interpretation of Status

Code (bits 55 ... 40)
1 Status Code is defined by manufacturer

62 ... 60 Reserved - -
59 ... 56 Diagnosis Class 0x0E Warning (C2D)

(see section Diagnosis messages of individual SWD
slaves (Diagnosis Class = Warning) [} page 66])

0x0F Error (C1D)
(see section Diagnosis messages generated by the
gateway (Diagnosis Class = Error) [} page 70])

55 ... 40 Status Code 0x0000 ... 0xFFFF In case of Diagnosis Class = 0x0E (warning), this is
the SWD-specific Diagnosis Code of the concerned
SWD slave.
In case of Diagnosis Class = 0x0F (error), see table
Diagnosis Codes of the Gateway in section Diagnosis
messages generated by the gateway (Diagnosis Class
= Error) [} page 70].

39 ... 24 Number of IO Function
Group

0x05E3 Complex protocol

23 ... 16 Slot Number 0x00 Gateway-specific diagnosis
0x01 ... 0x63 Address of concerned SWD slave

15 ... 8 Sub Bus Slave Index 0 -
7 ... 0 Channel Number 0 -

Table 25: Coding of IO Diagnostic Message
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11.2 Diagnosis messages of individual SWD slaves (Diagnosis
Class = Warning)

11.2.1 Overview “Warning”
Diagnostic messages issued by individual SmartWire-DT devices are
reported in IDN S-0-0390.0.0 (Diagnostic Number) as Diagnosis Class
= Warning (bits 19...16 = 0x0E). 
In this case the Status Code contains the corresponding SmartWire-DT
diagnosis code.

The diagnosis codes of individual SmartWire-DT slaves can be
looked-up in the user manual of the corresponding device (for
devices manufactured by Eaton, for example, this would be the
manual SmartWire-DT modules, MN05006001Z-EN).

In case of Diagnosis Class = Warning, the IDN S-0-0095.0.0
(Diagnostic Message) always contains the standard text SmartWire-DT
specific diagnosis. 
The address of the concerned SmartWire-DT slave is indicated in the Slot
Number (Bits 23 ... 16) of the IDN S-0-1500.0.32 (IO Diagnostic
Message).

Note:
Messages of Diagnosis Class = Warning do not need to be
acknowledged by the Sercos master. Once the cause of the
warning has been removed, the diagnosis gets cleared from the
IDNs.
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11.2.2 “Warning” example
The SmartWire-DT device EU2E-SWD-4DX at position #4 in the
SmartWire-DT network transmits diagnosis No sensor connected to
connector X2 (Status Code = 0x001C).

This diagnosis will be shown in IndraWorks®  as follows:
Ø Double-click the gateway in the Project Explorer, then open Status

tab.

Figure 30: SmartWire-DT specific Diagnosis
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S-0-0390.0.0 (Diagnostic Number)

Figure 31: Diagnostic Number for Warning

Bit Element Value Meaning
31 ... 30 Interpretation of bits 29 ... 0 0x00 Bits 29...16 (Source Type and

Diagnosis Class) are defined by
Sercos.
Bits 15...0 (Status Code) are
defined by manufacturer.

29 ... 24 Source Type 0x01 FSP IO (further details available in
IO Diagnostic message)

23 ... 20 Reserved - -
19 ... 16 Diagnosis Class 0x0E Warning (C2D)
15 ... 0 Status Code 0x001C SWD-specific Diagnosis Code of

the concerned SWD device:
„No sensor connected to connector
X2“ 
(see manual of concerned SWD
device)

Table 26: Coding of Diagnostic Number for Warning

S-0-0095.0.0 (Diagnostic Message)

Figure 32: Diagnostic Message for Warning
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S-0-1500.0.32 (IO Diagnostic Message)
Ø Open parameter editor, enter IDN S-0-1500.0.32 then press Enter

on your keyboard.

Figure 33: IO Diagnostic Message for Warning

Bit Element Value Meaning
63 Interpretation of Status

Code (bits 55 ... 40)
1 Status Code is defined by manufacturer

62 ... 60 Reserved - -
59 ... 56 Diagnosis Class 0x0E Warning (C2D)
55 ... 40 Status Code 0x001C SWD-specific Diagnosis Code of the

concerned SWD device:
„No sensor connected to connector X2“ 
(see manual of concerned SWD device)

39 ... 24 Number of IO Function
Group

0x05E3 1507 Complex Protocol

23 ... 16 Slot Number 0x04 Address of concerned SWD device (4)
15 ... 8 Sub Bus Slave Index 0x00 -
7 ... 0 Channel Number 0x00 -

Table 27: Coding of IO Diagnostic Message for Warning
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11.3 Diagnosis messages generated by the gateway (Diagnosis
Class = Error)

11.3.1 Overview “Error”
All diagnostic messages related to communication issues are reported in
IDN S-0-0390.0.0 (Diagnostic Number) as Diagnosis Class = Error
(bits 19...16 = 0x0F). 
This includes configuration errors, SmartWire-DT network errors and
internal errors of the gateway.

The Status Code contains the relevant diagnosis code. The IDN
S-0-0095.0.0 (Diagnostic Message) contains the corresponding
descriptive statement of the error cause.

In case the error is related to an individual SmartWire-DT slave (e. g. if a
mandatory slave device is missing in the SWD network), the address of the
concerned SWD slave is indicated in the Slot Number (bits 23 ... 16) of the
IDN S-0-1500.0.32 (IO Diagnostic Message).

Note:
Messages of Diagnosis Class = Error require an
acknowledgement by the Sercos master. Once the cause of the
warning has been removed, the diagnosis gets only cleared from
the IDNs after acknowledgement by the master.

The following table shows the diagnosis codes of the gateway that can be
conveyed in the Status Code elements of the IDNs S-0-0390.0.0 and
S-0-1500.0.32 next to the corresponding descriptive text statement of
the IDN S-0-0095.0.0 (Diagnostic Message):

Status Code Diagnostic Message Meaning
0x0001 Internal error Internal error of an SmartWire-DT slave
0x0002 Error loading target

configuration
Error while loading SmartWire-DT target
configuration

0x0003 Error checking target
configuration

Error while checking SmartWire-DT target
configuration

0x0004 Error saving target
configuration

Error while saving SmartWire-DT target
configuration

0x0005 Error checking project
configuration

Error while checking SmartWire-DT project
configuration

0x0006 No SmartWire-DT
modules detected

No SmartWire-DT slaves detected

0x0007 Unsupported SmartWire-
DT module detected

Unknown SmartWire-DT slave detected

0x0008 Max SmartWire-DT
modules exceeded

Maximum number of SmartWire-DT slaves
exceeded

0x0009 IO data timeout SmartWire-DT IO data exchange timeout
0x000A Error checking ASIC

Watchdog
Error while checking ASIC communication
Watchdog

0x000B Mandatory SmartWire-DT
module missing

Mandatory SmartWire-DT slave is missing

0x000C Optional SmartWire-DT
module missing

Optional SmartWire-DT slave is missing

Table 28: Diagnosis Codes of Gateway
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11.3.2 “Error” Example
The absence of a mandatory SmartWire-DT slave (in this example the
slave is expected at position #2 of the SmartWire-DT network) will be
diagnosed in IndraWorks®  as follows:
Ø Double-click the gateway in the Project Explorer, then open Status

tab.

S-0-0390.0.0 (Diagnostic Number)

Figure 34: Diagnostic Number for Error

Bit Element Value Meaning
31 ... 30 Interpretation of bits 29 ... 0 0x00 Bits 29...16 (Source Type and

Diagnosis Class) are defined by
Sercos.
Bits 15...0 (Status Code) are defined
by manufacturer.

29 ... 24 Source Type 0x01 FSP IO (further details available in IO
Diagnostic message)

23 ... 20 Reserved - -
19 ... 16 Diagnosis Class 0x0F Error (C1D)
15 ... 0 Status Code 0x000B Gateway-specific Diagnosis Code:

„Mandatory SmartWire-DT module
missing“ 
(see table Diagnosis Codes of
Gateway in section Overview
“Error” [} page 70])

Table 29: Coding of Diagnostic Number for Error

S-0-0095.0.0 (Diagnostic Message)

Figure 35: Diagnostic Message for Error
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S-0-1500.0.32 (IO Diagnostic Message)
Ø Open parameter editor, enter IDN S-0-1500.0.32 then press Enter

on your keyboard.

Figure 36: IO Diagnostic Message for Error

Bit Element Value Meaning
63 Interpretation of Status Code

(bits 55 ... 40)
1 Status Code is defined by

manufacturer
62 ... 60 Reserved - -
59 ... 56 Diagnosis Class 0x0F Error (C1D)
55 ... 40 Status Code 0x000B Gateway-specific Diagnosis

Code:
„Mandatory SmartWire-DT
module missing“ 
(see table Diagnosis Codes of
Gateway in section Overview
“Error” [} page 70])

39 ... 24 Number of IO Function
Group

0x05E3 1507 Complex Protocol

23 ... 16 Slot Number 0x02 Address of concerned SWD
slave (2)

15 ... 8 Sub Bus Slave Index 0x00 -

7 ... 0 Channel Number 0x00 -

Table 30: Coding of IO Diagnostic Message for Error

SmartWire-DT Gateway | EU5C-SWD-SERCOS 
DOC160805UM01EN | Revision 1 | English | 2017-02 | Released | Public

© Hilscher 2017



Changing IP address of gateway 73/95

12 Changing IP address of gateway

12.1 Overview
In its state of delivery, the EU5C-SWD-SERCOS gateway has the following
IP network settings:
· IP address: 192.168.0.1

· Subnet mask: 255.255.255.0

· Gateway address (standard gateway/router): 192.168.0.100

You can change the IP network settings of the gateway and adapt them to
your standard company network IP settings – e. g. in order to easily update
the firmware of the gateway via its web interface (for this, see also section
Updating firmware via web interface [} page 79]).

To change the IP network settings, use the following Sercos standard
parameter:
· Changing IP address: IDN S-0-1020.0.0

· Changing subnet mask: IDN S-0-1021.0.0

· Changing gateway address (standard gateway/router): IDN
S-0-1022.0.0

· Activate new settings (“procedure command”): IDN S-0-1048.0.0

Note:
To change its IP settings the gateway must be in communication
phase 2 (CP2).

The new settings can afterwards be checked by using the following IDNs:
· Reading IP address: IDN S-0-1020.0.1

· Reading subnet mask: IDN S-0-1021.0.1

· Reading gateway address (standard gateway/router): IDN
S-0-1022.0.1
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12.2 Example: Changing IP address of gateway with IndraWorks
This section shows how to change the IP network settings of the gateway
by using the IndraWorks® ML 14V10 P2 Engineering Tool.

Prerequisites
· You are connected and logged-in at the Sercos PLC/Master via

IndraWorks.
· The gateway is connected to the Sercos PLC/Master and is in

communication phase 2 (CP2).

Step-by-step instructions
1. Open parameter editor.

Ø In the Project Explorer, select the gateway then click  parameter
editor symbol in the tool bar:

Figure 37: Open parameter editor

Ê The parameter editor opens.
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2. Change IP address.
Ø In the IDN field, enter S-0-1020.0.0 then press Enter on your

keyboard.
Ø Enter new IP address values in fields 0 to 3 then press Enter on your

keyboard:

Figure 38: Changing IP address in parameter editor

3. Change subnet mask.
Ø In the IDN field, enter S-0-1021.0.0 then press Enter on your

keyboard.
Ø Enter new subnet mask values in fields 0 to 3 then press Enter on your

keyboard:

Figure 39: Changing subnet mask in parameter editor
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4. Change standard gateway/router address.
Ø In the IDN field, enter S-0-1022.0.0 then press Enter on your

keyboard.
Ø Enter new gateway/router address in fields 0 to 3 then press Enter on

your keyboard:

Figure 40: Changing standard gateway/router address in parameter editor

5. Activate new IP network settings.
Ø In the IDN field, enter S-0-1048.0.0 then press Enter on your

keyboard.
Ø In the Value field, set the last two digits to 11.
Ø Press Enter on your keyboard to issue this procedure command and to

activate the new IP settings of the gateway.

Figure 41: Activating new IP network settings
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6. Check new IP network settings.
Ø You can read the new IP network settings by using the IDNs

S-0-1020.0.1 (IP address), S-0-1021.0.1 (subnet mask) and
S-0-1022.0.1 (standard gateway/router address):

Figure 42: Checking new IP address
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13 Updating firmware

13.1 Overview
The EU5C-SWD-SERCOS Gateway is shipped with its most recent
firmware already loaded. The version of the loaded firmware is stated on
the device type label. 
The firmware can be easily updated via the Ethernet interface of the
Gateway. When you perform a firmware update, the old firmware file in the
gateway will automatically be overwritten. The project configuration and the
target configuration in the gateway remain untouched by the firmware
update.

Please note that updating firmware via Ethernet is only possible if the
gateway is connected to the SmartWire-DT network and if it has a valid
SmartWire-DT configuration (SWD LED of the gateway is showing steady
green light), otherwise the gateway will not activate its Ethernet interfaces
(PHYs).

Hazard of device damage by disruption of voltage supply during
firmware update!
Do not interrupt the voltage supply while updating the firmware of the
gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.

Note:
In case of a missing or defective firmware (which is indicated by a
green POW LED), the “regular” firmware update process described
in this chapter is not working. In this case, proceed as described in
chapter Firmware recovery via HTTP [} page 83].

There are two possible ways of updating the firmware:

Updating firmware via web interface of gateway

The integrated web server of the gateway provides a function to update the
firmware of the gateway by HTTP via its Ethernet interface. All you need is
a PC with an ordinary web browser connected to the gateway via Ethernet.
By entering the IP address 192.168.0.1 (this is the default address of the
gateway) into the address bar of your browser, you can connect to the
gateway’s web interface from where you can navigate to firmware update
page of the gateway. 
Step-by-step instructions for this can be found in section Updating firmware
via web interface [} page 79].
Instructions on how to change the IP address of the gateway can be found
in section Changing IP address of gateway [} page 73].
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Updating firmware via TFTP

You can also update the firmware of the gateway via Ethernet interface and
TFTP (Trivial File Transfer Protocol). For this you need a PC with a TFTP
client program (e. g. the open source freeware program Tftpd64) connected
to the gateway via Ethernet.

In your TFTP client program, you need to set the following parameters for
the gateway (which acts as TFTP server)

IP Address of Gateway: 192.168.0.1
TFTP-Port: 69
Local File: E030J0U0.nxf
Remote File: E030J0U0.nxf

Using the TFTP method is not described in this document, please consult
the documentation of your TFTP client program for more information.

13.2 Updating firmware via web interface

Prerequisites
· The gateway is supplied with voltage.
· The gateway is connected to a SmartWire-DT network.
· The gateway contains a valid SmartWire-DT configuration. The SWD

LED of the gateway shows steady green light (see position (4) in
section Positions of the LEDs [} page 26]).

· PC with web browser connected to an IP network.
· The Ethernet interface of the gateway is connected to the same IP

network as the PC.
· You have access to the SmartWire-DT Gateway Solutions DVD

respectively to the firmware file which you want to download to the
EU5C-SWD-SERCOS gateway (E030J0U0.nxf).

Step-by-step instructions
1. Open web page for firmware update.

Ø Start the web browser on your configuration PC.
Ø In the address bar of your browser, enter the URL of the gateway:

http://192.168.0.1

Note:
This is the default IP address of the gateway. Instructions on how to
customize the IP address can be found in section Changing IP
address of gateway [} page 73].

Ê The home page of the WebServer opens.
Ø In the navigation header of the web page, click Firmware Update.
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Note:
You can also open the firmware update page by entering the
IP address http://192.168.0.1/fwupdate in the address bar
of your browser.

Ê The following web page opens:

Figure 43: Firmware update via HTTP (as depicted in Internet Explorer)

The Firmware Identification section displays the following parameters of
the firmware currently loaded in the gateway:
· Channel: Location (port) of firmware
· Name: Name of loaded firmware
· Version: Version of loaded firmware
· Date: Date of creation of loaded firmware

The Firmware Update section features the following control elements:
Control element Function
Browse… Opens the file selection dialog
Transfer Uploads selected firmware file to the device
Cancel Cancels firmware update

Table 31: Controls in Firmware Update Page

2. Select new firmware file.
Ø Click Browse… button, to open a dialog window for selecting the

firmware file.
Ø Navigate to the directory in which the firmware file is stored, select the

file, and then click Open.

Note:
The name of the firmware file for the Sercos gateway is
E030J0U0.nxf
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Ê Path and name of the selected file are displayed in the field next to the
Browse… button.

3. Download firmware file to gateway.

Hazard of device damage by disruption of voltage supply during
firmware update!
Do not interrupt the voltage supply while updating the firmware of the
gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.

Ø Click Transfer button to download the new firmware file to the gateway.
Ê After you have started the upload by clicking the Transfer button, the

validity of the firmware file is being checked by the system. If the file
fails the validity check, the file will not be stored in the gateway and an
error message will be displayed. If the file passes, the old firmware file
in the gateway is overwritten by the new firmware. This might take a
minute. Afterwards, the WebServer requests a reset, in order to start
the new firmware.

4. Reset gateway.
Ø To open the reset page, click Reset in the navigation header.

Note:
You can also open the reset page by entering the IP address
http://192.168.0.1/reset in the address bar of your browser.

Ê The following web page opens:

Figure 44: Reset via HTTP (as depicted in Internet Explorer)

Important:
Please note the following consequences of a reset:
The firmware is being restarted and connections will be interrupted
or timed out.
I/O bus communication is being stopped.
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5. Perform reset.
Ø Activate the checkbox in front of Please confirm… to acknowledge that

you want to reset the device.

Note:
You can use the Cancel button to uncheck the checkbox in front of
Please confirm...

Ø Click Submit button to start the reset.
ð The device is being reset.
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14 Firmware recovery via HTTP

14.1 Overview
If the POW system status LED of the gateway shows steady green light,
the “regular” firmware of the gateway is defective or missing (for the
position of the POW LED see section Positions of the LEDs [} page 26]).

In this case only the so-called “backup firmware” is running and the device
is not able to perform its normal gateway functions. This state can be
resolved by downloading a fresh (i. e. uncorrupted) firmware file into the
gateway via HTTP protocol. The backup firmware (which is part of the boot
strap loader running in the gateway) carries a “web server” functionality for
downloading a firmware file comfortably via its Ethernet interface.

For this, you just have to connect the gateway via its Ethernet interface to
an active DHCP server and a configuration PC. The purpose of the DHCP
server is to assign an IP address to the gateway. This assigned IP address
can then be used by the configuration PC to connect to the download
function of the backup firmware running in the gateway, in order to
download the new firmware file via ordinary web browser. 
If you do not know the exact IP address assigned to the gateway by the
DHCP server, you can use the Hilscher Ethernet Device Configuration
Tool on your configuration PC (included on the product DVD) in order to
“read out” the newly assigned IP address from the gateway. (The tool uses
the netIDENT protocol to search for all Hilscher devices within the
connected IP network, and then lists all found devices and their IP
addresses.)

Note:
This chapter describes only how to download the recovery firmware.
Instructions on how to configure and operate a DHCP server are not
subject of this manual. For information on using a DHCP server,
please consult your local network administrator.
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14.2 Prerequisites
· The gateway is supplied with voltage and the backup firmware inside

the device is running (this is indicated by steady green light at the POW
LED)

· The gateway is disconnected from the Sercos network
· The gateway is connected to an active DHCP server via local Ethernet

network
· The gateway is connected via local Ethernet network to a configuration

PC with installed standard web browser
· You have access to the firmware file which you want to download to the

gateway (the firmware is stored on the SmartWire-DT Gateway
Solutions product DVD in the Firmware\EU5C-SWD-SERCOS
\Vx.x.x.x folder).

· You know the IP address, which the DHCP server has assigned to the
gateway. If not, install the Hilscher Ethernet Device Configuration
Tool on your configuration PC. This tool allows you to check the current
IP address of the gateway (if the configuration PC and the gateway are
connected to the same local Ethernet network). An installer for this
program can be found on the product DVD in the Software
\EnDeviceCfg folder (the program can also be installed by using the
menu of the product DVD.)

14.3 Step-by-step instructions
1. Use DHCP server to assign IP address to gateway.

Ø Disconnect the gateway from the voltage supply.
Ø Plug a cable connected to the local Ethernet network (in which a DHCP

server is active) into one of the Ethernet RJ45 sockets on the front side
of the gateway.

Ø Reconnect the gateway to the voltage supply.

Note:
The L/A LINK/Activity LEDs of the Ethernet RJ45 sockets remain
dark when an Ethernet cable is plugged-in while the backup
firmware is running – even if a successful IP communication with an
local Ethernet network has been established.

Ê The backup firmware running in the device now sends a so-called
DHCPDISCOVER message broadcast into the Ethernet network,
requesting an IP address from a DHCP server. If a DHCP service is
available in the network, the gateway should be receiving a valid IP
address from the server within a few seconds.
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2. Check IP address.
Ø In the Windows Start menu of your configuration PC, select All

Programs > Hilscher GmbH > Ethernet Device Configuration, to
start the Ethernet Device Configuration Tool.

Ê The Ethernet Device Configuration tool opens:

Figure 45: Ethernet Device Configuration Tool

Ø Click Search Devices button, to start searching for the gateway within
the local Ethernet network.

Ê The tool starts scanning for devices and lists all found Hilscher devices
and their IP addresses:

Figure 46: Found gateway in Ethernet Device Configuration Tool

Ø Note or write down the IP address.
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Note:
If the default IP address 0.0.0.0 is displayed, the gateway has not
yet received an IP address from a DHCP server. Make sure that the
gateway is connected to a subnet with an active DHCP server.
Then restart the gateway by briefly disconnecting the voltage supply
while the Ethernet cable remains plugged-in. Wait a few seconds
after reconnecting the voltage supply, then click the Search
Devices button in the Ethernet Device Configuration Tool again.

3. Open web page for firmware download.
Ø Start the web browser on your configuration PC.
Ø In the address bar of your browser, enter the IP address of the gateway:

http://<IP address>

Ê The Firmware Update page opens:

Figure 47: Firmware recovery via HTTP (as depicted in Internet Explorer)

4. Select firmware file for download.
Ø Click Browse… button, to open a dialog window for selecting the

firmware file you want to download.
Ø Navigate to the directory in which the firmware file is stored, select the

file, then click Open.

Note:
The name of the firmware file for the EU5C-SWD-SERCOS
gateway is E030J0U0.nxf

Ê Path and name of the selected file are displayed in the field next to the
Browse… button.
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5. Download firmware file to gateway.
Ø Click Transfer button to download the new firmware file to the gateway.
Ê After you have started the download by clicking the Transfer button, the

validity of the firmware file is being checked by the system. If the file
fails the validity check, an error message will be displayed. If the file
passes, the gateway requests you to perform a reset in order to start
the new firmware:

Figure 48: Reset after firmware download via HTTP (as depicted in Internet Explorer)

6. Perform reset.
Ø Activate the checkbox in front of Please confirm… to acknowledge that

you want to reset the gateway.

Note:
You can use the Cancel button to uncheck the checkbox in front of
Please confirm...

Ø Click Submit button to start the reset.
Ê After successful reset, the following message is displayed:

Figure 49: Successful device reset message (as depicted in Internet Explorer)
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ð The POW system status LED at the gateway shows steady yellow light.
The new firmware has been loaded and the gateway is ready for
operation.
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15 Technical data

15.1 Technical data EU5C-SWD-SERCOS gateway
Category Parameter Value
General Part number 9233.923

Dimensions
(W x H x D)

35 x 90 x 127 mm

Weight 160 g
Mounting Top hat rail 35 mm (IEC/EN 60715)
Mounting position Vertical
Standards IEC/EN 61131-2
Communication controller netX 50 processor
Configuration and diagnostic interface Mini-USB
Integrated memory 8 MB SDRAM

4 MB serial Flash EPROM
Ambient mechanical
conditions

Protection type
(IEC/EN 60529, EN50178, VBG 4)

IP20

Vibrations
(IEC/EN 61131-2:2008)

Constant amplitude 3.5 mm: 5 – 9 Hz
Constant acceleration 1 g: 9 – 150 Hz

Mechanical shock resistance
(IEC/EN 60068-2-27)

Semi-sinusoidal 15 g/11 ms: 9 Shocks

Drop to
(IEC/EN 60068-2-31)

Drop height: 50 mm

Free fall, packaged
(IEC/EN 60068-2-32)

Drop height: 1 m

Ambient climatic conditions Operating ambient temperature
(IEC 60068-2)

-25…+55 °C

Condensation Prevent by suitable measures
Storage -40…+70 °C
Relative humidity, non-condensing
(IEC/EN 60068-2-30)

5…95 %

Electromagnetic
compatibility (EMC)

Pollution degree 2
Electrostatic discharge
(IEC/EN 61131-2:2008)

Air discharge (Level 3): 8 kV
Contact discharge (Level 2): 4 kV

Electromagnetic fields (IEC/EN
61131-2:2008)

80 – 1000 MHz: 10 V/m
1.4 – 2 GHz: 3 V/m
2 – 2.7 GHz: 1 V/m

Radio interference suppression
(SmartWire-DT)

EN 55011 Class A

Burst
(IEC/EN 61131-2:2008, Level 3)

Supply cables: 2 kV
Sercos bus cable: 1 kV
SmartWire-DT cables: 1 kV

Surge
(IEC/EN 61131-2:2008, Level 1)

Supply cables: 0.5 kV
Sercos bus cable: 1 kV

Radiated RFI
(IEC/EN 61131-2:2008, Level 3)

0,15 – 80 MHz, 10 V, 80% AM / 1 KHz
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Category Parameter Value
Supply voltage
UAUX

Rated operational voltage 24 V DC
-15 % +20 %

Input voltage residual ripple ≤ 5 %
Protection against polarity reversal Yes
max. current Imax 3 A

Note: If contactors with a total power consumption >
3 A are connected, a power feeder module EU5C-
SWD-PF1/2 has to be used.

Short-circuit strength No, external fuse FAZ Z3
Heat dissipation Typ. 1 W
Potential isolation No
Rated operating voltage of 24-V-DC
slaves

Typ. UAUX -0,2 V

Supply voltage
UPOW

Supply voltage 24 V DC
-15 % +20 %

Protection against polarity reversal ≤ 5 %
Protection against polarity reversal Yes
Rated operational current I 111 mA (with two participants)
Heat dissipation at 24 V DC 2.66 W (with two participants)
Potential isolation between UPOW and
15-V-SmartWire-DT supply voltage

No

Bridging voltage dips 10 ms
Repeat rate 1 s
Status display POW LED

SmartWire-DT supply
voltage

Rated operational voltage Ue 15 V ± 3 %
max. current Imax 0.7 A

Note: If contactors with a total power consumption >
0.7 A are connected, a power feeder module EU5C-
SWD-PF2 has to be used.

Short-circuit strength Yes
Connection supply
voltages

Connection type Push-in terminals
solid 0,2 – 1,5 mm2 (AWG 24 – 16)
Flexible with ferrule 0,25 – 1,5 mm2

SmartWire-DT network Participant type SmartWire-DT master
SmartWire-DT Master ASIC SWD-80P-RS485
Number of SmartWire-DT slaves 99
Baud rate 125 / 250 kBd
Address setting Automatic
Status display SmartWire-DT master: SWD LED, duo color red/

green
Configuration: Config LED, duo color red/green

Connections Plug, 8-pole
Plug connectors Blade terminal SWD4-8MF2

SmartWire-DT Gateway | EU5C-SWD-SERCOS 
DOC160805UM01EN | Revision 1 | English | 2017-02 | Released | Public

© Hilscher 2017



Technical data 91/95

Category Parameter Value
Ethernet Sercos network Function of gateway Sercos Slave

Baud rate 100 MBit/s
Interface type 100 BASE-TX
Auto-Negotiation Supported
Auto-Crossover Supported
Address setting By project configuration
Status display Sercos LED: S,

duo color red/green (orange)
Connector socket 2 x RJ45
Connector plug RJ45
Potential isolation Yes

Table 32: Technical data EU5C-SWD-SERCOS gateway

15.2 Technical data Sercos slave
Parameter Value
Maximum number of cyclic produced data 246 bytes (including 2 bytes Connection

Control and 2 bytes IO Status)
Maximum number of cyclic consumed data 246 bytes (including 2 bytes Connection

Control and 2 bytes IO Control)
Sercos address 1 … 511
Minimum cycle time 250 µs (the reachable minimum cycle time

depends on the number of input and output
data used)

Topology Line and ring
Communication phases NRT, CP0, CP1, CP2, CP3, CP4, HP0, HP1,

HP2
Connections 1 Consumer Connection

1 Producer Connection
Cross Communication (CC) Supported
Acyclic communication (Service channel) Read, write, and standard commands
Supported Sercos version Third generation of Sercos

Communication specification version 1.1.2
Supported Sercos Communication Profiles
(SCP)

SCP_FixCFG (Version 1 and 2)
SCP_HP (Version 1)
SCP_SysTime (Version 1)
SCP_Sync (Version 1 and 2)
SCP_NRTPC (Version 1)
SCP_SIP (Version 1)
SCP_TFTP (Version 1)
SCP_Diag (Version 1)
SCP_Syc (Version 1)

Supported Generic Device Profiles (GDP) GDP_Basic (Version 1)
GDP_PWD (Version 1)
GDP_DiagT (Version 1)
GDP_Id (Version 1)
GDP_Rev (Version 1)
GDP_RST (Version 1)

Supported Function Specific Profile (FSP) FSP_IO
Reference to firmware version / stack
version

V1.0.6 / V3.3

Table 33: Technical data Sercos Slave protocol
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